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The Building Automation Systems Sensors MKII BoosterPack™ Plug-in Module kit (BP-
BASSENSORSMKII) is an easy-to-use module for adding digital sensors to your LaunchPad™
development kit design. SimpleLink™ microcontroller (MCU) LaunchPad development kit developers can
use this BoosterPack plug-in module to start developing sensor applications using the onboard
temperature, humidity, ambient light, and magnetic flux sensors, as well as the included inertial
measurement unit (IMU) and magnetometer.

Figure 1. BP-BASSENSORSMKII BoosterPack Plug-in Module
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1 Getting Started

1.1 Introduction
The Building Automation Systems Sensors MKII BoosterPack Plug-in Module kit (BP-BASSENSORSMKII)
is an easy-to-use module for adding digital sensors to the LaunchPad development kit design. For these
SimpleLink MCU LaunchPad development kits, engineers can use this BoosterPack plug-in module to
start developing sensor applications using the onboard temperature, humidity, ambient light, and magnetic
flux sensors, as well as the included inertial measurement unit (IMU) and magnetometer.

1.2 Key Features
• High-Accuracy Temperature Sensor (TMP117)
• Combined Temperature and Humidity Sensor (HDC2080)
• Ambient Light Sensor (OPT3001)
• Hall Effect Sensor (DRV5055-Q1)
• Bosch BMI160 Inertial measurement Unit, and BMM150 Magnetometer
• Works With TI LaunchPad Development Kits

1.3 What's Included

1.3.1 Kit Contents
• 1x BP-BASSENSORSMKII BoosterPack plug-in module
• 1x 3" Breakout Ribbon Cable

1.4 Next Steps: Looking Into the Provided Code
The next steps after reviewing the EVM features are to open an integrated development environment
(IDE) and start looking at the code examples. Section 3 describes the example projects available for the
user to understand the provided software.

http://www.ti.com
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2 Hardware
Figure 2 shows an overview of the BoosterPack plug-in module.

Figure 2. BP-BASSENSORSMKII Overview

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829


www.ti.com Hardware

5SLAU829–May 2020
Submit Documentation Feedback

Copyright © 2020, Texas Instruments Incorporated

BP-BASSENSORSMKII user's guide

2.1 Hardware Features

2.1.1 BoosterPack™ Plug-in Module Pinout
Figure 3 shows the pinout of the BoosterPack plug-in module.

Figure 3. BoosterPack™ Plug-In Module Pinout

The Building Automation Systems Sensors MKII BoosterPack plug-in module adheres to the 40-pin
LaunchPad development kit and BoosterPack plug-in module pinout standard. A standard was created to
aid compatibility between LaunchPad development kits and BoosterPack plug-in modules across the TI
ecosystem.

The 40-pin standard on the BP-BASSENSORSMKII is compatible with the 20-pin standard that is used by
other LaunchPad development kits like the MSP-EXP430G2 LaunchPad development kit. This
compatibility allows for 40-pin BoosterPack plug-in modules to be used with 20-pin LaunchPad
development kits.

The BP-BASSENSORSMKII BoosterPack plug-in module has both male and female headers to support
stacking on top. The user must carefully consider stacking other BoosterPack plug-in modules near the
BASSensors MKII BoosterPack plug-in module as heat, shade, and electromagnetic fields can adversely
affect the sensors readings.

For more information on EVM compatibility with TI LaunchPad development kits, refer to
www.ti.com/launchpad.

2.1.2 I2C Addresses

Device 7 bit Address Hex (7 bit)
OPT3001 1000100 44
TMP117 1001000 48

HDC2080 1000000 40
BME150 0001101 13
BME160 1101001 69

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://www.ti.com/tool/bp-bassensorsmkii
http://www.ti.com/tool/msp-exp430g2
http://www.ti.com/tool/bp-bassensorsmkii
http://www.ti.com/launchpad
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2.1.3 TI OPT3001 Light Sensor
The OPT3001 is a digital ambient light sensor (ALS) that measures the intensity of light as visible by the
human eye. Covering the sensor with a finger or shining a flashlight on it changes the output of the
OPT3001. The digital output is reported over an I2C- and System Management Bus (SMBus)-compatible,
2-wire serial interface. The reference designator for the OPT3001 is U2. Table 1 lists the pin connections
of the OPT3001.

For more information on the OPT3001 light sensor, refer to the OPT3001 product folder.

(1) I2C Pins are shared amongst the TMP117, HDC2080, BMI160, and
OPT3001.

Table 1. OPT3001 Pinout

BoosterPack™ Plug-in Module
Header Connection Pin Function

J1.9 (1) I2C SCL
J1.10 (1) I2C SDA
J1.27 OPT3001 V+ Supply Pin
J1.25 OPT3001 INT Pin

2.1.4 TI TMP117 Temperature Sensor
The TMP117 is a 16-bit digital local temperature sensor that measures the ambient temperature or the
temperature of an object in direct contact. Despite being a contact sensor, the sensitivity and accuracy of
the TMP117 is high enough to detect a change in temperature from a hand placed near the sensor. The
digital output is reported over an I2C- and SMBus-compatible, 2-wire serial interface. The reference
designator for the TMP117 is U6. Table 2 lists the pin connections of the TMP117.

In order to use the TMP117, the included ribbon cable must be connected. The metal contacts of the
cable must face down in the connector to make electrical contact. The black tab on the cable should be
face up.

For more information on the TMP117 temperature sensor, refer to the TMP117 product folder.

(1) I2C Pins are shared amongst TMP117, HDC2080, BMI160, and
OPT3001.

Table 2. TMP117 Pinout

BoosterPack™ Plug-in Module
Header Connection Pin Function

J1.9 (1) I2C SCL
J1.10 (1) I2C SDA
J1.28 TMP117 V+ Supply Pin
J1.26 TMP117 ALERT Pin

2.1.5 TI HDC2080 Humidity Sensor
The TI HDC2080 is an integrated temperature and humidity sensor that measures ambient temperature
and relative humidity in RH%. The sensor can detect moisture in the surrounding environment as it
saturates the polymer sensing element on top side of the device. The digital output is reported over an
I2C- and SMBus-compatible 2-wire serial interface. The reference designator for the HDC2080 is U3.
Table 3 lists the pin connections of the HDC2080. Note that Pin J1.28 must drive a Logic Low or zero to
enable gate Q2 and power HDC2080.

For more information on the HDC2080 humidity sensor, refer to the HDC2080 product folder.

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://www.ti.com/product/opt3001
http://www.ti.com/product/tmp117
http://www.ti.com/product/hdc2010


www.ti.com Hardware

7SLAU829–May 2020
Submit Documentation Feedback

Copyright © 2020, Texas Instruments Incorporated

BP-BASSENSORSMKII user's guide

(1) I2C Pins are shared amongst TMP117, HDC2080, BMI160, and
OPT3001.

Table 3. HDC2080 Pinout

BoosterPack™ Plug-in Module
Header Connection Pin Function

J1.9 (1) I2C SCL
J1.10 (1) I2C SDA

J1.6 Enable HDC2080 3.3V Supply
(Inverted)

J1.23 HDC2080 INT Pin

2.1.6 TI DRV5055-Q1 Hall Effect Sensor
The TI DRV5055-Q1 Hall Effect sensor measures the strength of magnetic fields in one axis. Placing a
magnet near the sensor increases the sensor output. The output of the sensor is an analog voltage which
must be sampled by an ADC and converted to milliTesla. The reference designator for the DRV5055-Q1 is
U4. Table 4 lists the pin connections of the DRV5055-Q1. Note that Pin J1.24 must drive a Logic Low or
zero to enable gate Q1 and power DRV5055.

For more information on the DRV5055-Q1 hall effect sensor, refer to the DRV5055-Q1 product folder.

Table 4. DRV5055-Q1 Pinout

BoosterPack™ Plug-in Module
Header Connection Pin Function

J1.2 DRV5055-Q1 Analog Output

J1.24 Enable DRV5055-Q1 3.3-V Supply
(Inverted)

2.1.7 Bosch® BMI160 Inertial Measurement Sensor
The Bosch BMI160 inertial measurement unit is a 6-axis digital accelerometer and gyroscope sensor that
measures gravitational forces exerted on the device, as well as the speed of rotation in degrees per
second. The BMI160 can synchronize its own accelerometer and gyroscope data as well as with an
external device such as a geomagnetic sensor. Rotating the board about its axis increases the gyroscope
output of the sensor, and changing the orientation of the board with respect to the earth changes it
accelerometer output. The BMI160 has a secondary I2C interface for connecting additional Bosch sensors
such as the BMM150 geomagnetic sensor. The digital output of both sensors is reported over an I2C- and
SMBus-compatible 2-wire serial interface. The reference designator for The BMI160 is U1.

More information on The BMI160 inertial measurement unit can be found at https://www.bosch-
sensortec.com/products/motion-sensors/imus/bmi160.html.

(1) I2C Pins are shared amongst TMP117, HDC2080, BMI160, and
OPT3001.

Table 5. BMI160 Pinout

BoosterPack™ Plug-in Module
Header Connection Pin Function

J1.9 (1) I2C SCL
J1.10 (1) I2C SDA

J1.5 BMI160 INT1
J2.13 BMI160 INT 2

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://www.ti.com/product/drv5055-q1
https://www.bosch-sensortec.com/products/motion-sensors/imus/bmi160.html
https://www.bosch-sensortec.com/products/motion-sensors/imus/bmi160.html
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2.1.8 Bosch BMM150 Geomagnetic Sensor
The Bosch BMM150 geomagnetic sensor is a 3-axis digital magnetometer sensor that measures the
strength of the magnetic fields in microtesla for e-compass applications. The BMM150 can be used in
combination with the BMI160 for 9-axis sensing. Placing a magnet near the sensor increases the sensor
output. The BMM150 is connected to the BMI160 as a secondary I2C device, and all of its sensor data is
passed to the BMI160 to be reported out over an I2C- and SMBus-compatible, 2-wire serial interface. The
reference designator for the BMM150 is U5.

More information on the BMM150 geomagnetic sensor can be found at https://www.bosch-
sensortec.com/products/motion-sensors/magnetometers-bmm150/.

Table 6. BMM150 Pinout

BoosterPack™ Plug-in Module
Header Connection Pin Function

J1.8 BMM150 INT

2.2 Power
The board is designed to be powered by the attached LaunchPad development kit.

2.2.1 LaunchPad™ Development Kit Default Power
Power is provided through the 3V3 (J1.1) pin on the BoosterPack plug-in module headers. The 3V3 pin
powers everything on the BASSensors BoosterPack plug-in module.

2.3 Design Files

2.3.1 Hardware
Schematics can be found in Section 5. All design files including schematics, layout, bill of materials
(BOM), Gerber files, and documentation are available on the BP-BASSENSORSMKII Hardware Design
Files on the download page.

2.3.2 Software
All design files including software example projects, and documentation are available in the software
folders that are specific to each LaunchPad development kit.

2.4 Hardware Change Log
Table 7 lists the hardware revision history.

Table 7. Hardware Change Log

PCB Revision Description
Rev 1.0 Initial release

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
https://www.bosch-sensortec.com/products/motion-sensors/magnetometers-bmm150/
https://www.bosch-sensortec.com/products/motion-sensors/magnetometers-bmm150/
http://www.ti.com/tool/BP-BASSENSORSMKII
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3 Software Examples
The following software examples are included with the Sensor and Actuator Plugin for SimpleLink MCU
SDKs (see Table 8). These examples can be found in the SIMPLELINK-SDK-SENSOR-ACTUATOR-
PLUGIN , which is commonly installed as C:\ti\sail. Note that the SimpleLink SDK for your MCU must be
installed alongside the SAIL plugin. Within the sail folder, the software examples are located in
examples/rtos/[LaunchPad]/sail/. The software examples are compatible with the following LaunchPads:
• CC1310_LAUNCHXL
• CC1352R_LAUNCHXL
• CC2640R2_LAUNCHXL
• CC3220S_LAUNCHXL
• CC3220SF_LAUNCHXL
• MSP_EXP432E401Y
• MSP_EXP432P401R

Table 8. Software Examples

Demo Name
LaunchPad™ /
BoosterPack™

Required
Description More Details

adcdrv5055 SimpleLink MCU / BP-
BASSENSORSMKII

Samples voltage from DRV5055-Q1 using MCU
Onboard ADC, convert voltage to milliTesla and
report using UART.

Section 3.1

i2cHDC2080 SimpleLink MCU / BP-
BASSENSORSMKII

Sample data from HDC2080 using I2C, convert
to temperature/humidity and report using UART. Section 3.2

i2copt3001 SimpleLink MCU / BP-
BASSENSORSMKII

Sample data from OPT3001 using I2C, convert
to lux and report using UART. Section 3.3

i2cTMP117 SimpleLink MCU / BP-
BASSENSORSMKII

Sample data from TMP117 using I2C, convert to
temperature and report using UART. Section 3.4

i2cbmi160 SimpleLink MCU / BP-
BASSENSORSMKII

Sample data from BMI160 and BMM150 and
report 9 DoF (Degrees of Freedom) data using
UART.

Section 3.5

To use one of the software examples with the LaunchPad development kit, the user must have an
integrated development environment (IDE) that supports the SimpleLink MCU devices (see Table 9).

Table 9. IDE Minimum Requirements

Code Composer Studio™ IDE IAR Embedded Workbench® for ARM® IDE ARM® Keil® µVision® IDE
v7.1.0 v7.80.3 MDK-ARM v5

For more details on how to get started quickly, and where to download the latest CCS, IAR, and Keil IDEs,
see Section 4.

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://www.ti.com/tool/download/SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN
http://www.ti.com/tool/download/SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN
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3.1 DRV5055-Q1 Software Example
This section describes the functionality and structure of the adcdrv5055 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/adcdrv5055

3.1.1 Source File Structure
The project is split into multiple files (see Table 11). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.

Table 10. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software

tirtos/gcc CCS project files used for importing this Software Example into Code Composer Studio software
using the gcc compiler

tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench

adcdrv5055.c Contains MainThread for RTOS application and function which queries ADC connected to
DRV5055-Q1

Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://www.ti.com/tool/download/SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN
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3.2 HDC2080 Software Example
This section describes the functionality and structure of the i2cHDC2080 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/i2cHDC2080

3.2.1 Source File Structure
The project is split into multiple files (see Table 11). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.

Table 11. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software

tirtos/gcc CCS project files used for importing this Software Example into Code Composer Studio software
using the gcc compiler

tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench
i2cHDC2080.c Contains MainThread for RTOS application and function which queries HDC2080 using I2C
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://www.ti.com/tool/download/SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN
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3.3 OPT3001 Software Example
This section describes the functionality and structure of the i2copt3001 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/i2copt3001.

3.3.1 Source File Structure
The project is split into multiple files (see Table 11). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.

Table 12. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software

tirtos/gcc CCS project files used for importing this Software Example into Code Composer Studio software
using the gcc compiler

tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench
i2copt3001.c Contains MainThread for RTOS application and function which queries OPT3001 using I2C
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
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3.4 TMP117 Software Example
This section describes the functionality and structure of the i2cTMP117 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/i2cTMP117.

3.4.1 Source File Structure
The project is split into multiple files (see Table 11). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.

Table 13. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software

tirtos/gcc CCS project files used for importing this Software Example into Code Composer Studio software
using the gcc compiler

tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench
i2cTMP117.c Contains MainThread for RTOS application and function which queries TMP117 using I2C
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
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3.5 BMI160/BMM150 Software Example
This section describes the functionality and structure of the i2cbmi160 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/i2cbmi160.

3.5.1 Source File Structure
The project is split into multiple files (see Table 14). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.

Table 14. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software

tirtos/gcc CCS project files used for importing this Software Example into Code Composer Studio software
using the gcc compiler

tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench

i2cbmi160.c Contains Main thread for RTOS application and function which queries BMI160 and BMI150 using
12C.

i2cbmi160_support.c Support driver for communicating with the BMI160 and BMI150.
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
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4 Additional Resources

4.1 TI LaunchPad™ Development Kit Portal
More information about LaunchPad development kits, supported BoosterPack plug-in modules, and
available resources can be found at:
• TI's LaunchPad portal: Information about all LaunchPad development kits from TI, for all

microcontrollers

4.2 TI Cloud Development Tools
TI's Cloud-based software development tools provide instant access to SimpleLink SDK content and a
web-based IDE.

4.2.1 TI Resource Explorer Cloud
TI Resource Explorer Cloud provides a web interface for browsing examples, libraries, and documentation
found in the SimpleLink SDK without having to download files to the local drive (see Figure 4).

Learn more about TI Resource Explorer Cloud at https://dev.ti.com/.

Figure 4. TI Resource Explorer Cloud

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://www.ti.com/launchpad
https://dev.ti.com/
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4.2.2 Code Composer Studio™ Cloud IDE
Code Composer Studio Cloud (CCS Cloud) IDE is a web-based IDE that lets you quickly create, edit,
build, and debug applications for the LaunchPad development kit (see Figure 5). There is no need to
download and install large software packages. You simply connect the LaunchPad development kit and
begin. The user can choose to select from a large variety of examples in the SimpleLink MSP432 SDK
and Energia or develop their own application. CCS Cloud IDE supports debug features such as execution
control, breakpoints, and viewing variables.

A full comparison between CCS IDE Cloud and CCS Desktop is available here.

Learn more about Code Composer Studio Cloud IDE at https://dev.ti.com/.

Figure 5. CCS Cloud

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
https://dev.ti.com/
https://dev.ti.com/
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4.3 Code Composer Studio™ IDE
Code Composer Studio IDE Desktop is a professional integrated development environment that supports
TI's microcontroller and Embedded Processors portfolio. Code Composer Studio IDE comprises a suite of
tools used to develop and debug embedded applications. It includes an optimizing C/C++ compiler, source
code editor, project build environment, debugger, profiler, and many other features.

Learn more about CCS IDE and download it at www.ti.com/tool/ccstudio.

CCS IDE v6.1 or higher is required. When CCS has been launched, and a workspace directory chosen,
use Project>Import Existing CCS Eclipse Project. Direct it to the project directory that contains the main.c
of the desired demo (see Figure 6).

Figure 6. Directing the Project>Import Function to the Demo Project

The user can also select the \CCS subdirectory. The CCS-specific files are located there.

When the user clicks OK, the CCS recognizes the project and allows the import.

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://www.ti.com/tool/ccstudio
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The project appears in the Import CCS Eclipse Projects window and has a checkmark to the left of it if the
CCS found the project (see Figure 7).

Figure 7. When CCS Has Found the Project

Sometimes the CCS IDE finds the project but does not show a checkmark. This may mean that the
workspace already has a project by that name. The user can either rename or delete that project to fix this
issue. If the project does not appear in the CCS IDE workspace, make sure to check the workspace
directory on the file system.

4.4 IAR Embedded Workbench® for TI MSP430™ MCUs
IAR Embedded Workbench for MSP430™ MCUs is another very powerful integrated development
environment that allows you to develop and manage complete embedded application projects. IAR
Embedded Workbench integrates the IAR C/C++ Compiler, IAR Assembler, IAR ILINK Linker, editor,
project manager, command line build utility, and IAR C-SPY® Debugger.

Learn more about the IAR Embedded Workbench for MSP430 MCUs and download the software at
www.iar.com/.

IAR 6.10 or higher is required. To open the demo in IAR, click File>Open>Workspace…, and browse to
the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is
contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by
clicking Project>Add-Existing-Project….

Although the software examples have all of the code required to run them, IAR users may download and
install MSP430Ware™ software that contains MSP430 MCU libraries and the TI Resource Explorer.
These are already included in a Code Composer Studio IDE installation unless the user selected
otherwise.

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
https://www.iar.com/


www.ti.com Additional Resources

19SLAU829–May 2020
Submit Documentation Feedback

Copyright © 2020, Texas Instruments Incorporated

BP-BASSENSORSMKII user's guide

4.5 Energia
Energia is a simple, open-source, and community-driven code editor that is based on the Wiring and
Arduino framework. Energia provides unmatched ease of use through very high-level APIs that can be
used across hardware platforms. Energia is a lightweight IDE that does not have the full feature set of
Code Composer Studio IDE or IAR Embedded Workbench IDE. However, Energia is great for anyone who
wants to get started very quickly or who does not have significant coding experience.

Learn more about Energia and download it at www.energia.nu.

4.6 SimpleLink™ MSP432 SDK, MSP430Ware™ Software, and TI Resource Explorer
The MSP432 device is part of the SimpleLink microcontroller (MCU) platform, which consists of Wi-Fi®,
Bluetooth® low energy, Sub-1 GHz, and host MCUs. All share a common, easy-to-use development
environment with a single core software development kit (SDK) and rich tool set. A one-time integration of
the SimpleLink platform lets you add any combination of devices from the portfolio into your design. The
ultimate goal of the SimpleLink platform is to achieve 100 percent code reuse when your design
requirements change. For more information, visit www.ti.com/simplelink.

For the 16-bit MSP430 MCUs, the MSP430Ware software package is used. MSP430Ware software is a
complete collection of libraries and tools. It includes a driver library (driverlib) graphics library (grlib), and
many other software tools. MSP430Ware software is optionally included in a Code Composer Studio IDE
installation or can be downloaded separately. IAR users must download it separately.

Both the SimpleLink MSP432 SDK and the MSP430Ware software are included in the TI Resource
Explorer for easily browsing tools, documents, examples, and more (see Figure 8).

Figure 8. TI Drivers Software Examples in TI Resource Explorer

Inside TI Resource Explorer, these examples and many more can be found and easily imported into Code
Composer Studio IDE with one click.

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://wiring.org.co/
http://arduino.cc/
http://www.energia.nu/
http://www.ti.com/simplelink
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4.7 The Community

4.7.1 TI E2E™ Online Community
Search the forums at e2e.ti.com for helping building your EVM boards. If you cannot find the answer, post
a question to the community.

4.7.2 Community at Large
Many online communities focus on the LaunchPad development kit and BoosterPack plug-in module
ecosystem like www.43oh.com. You can find additional tools, resources, and support from these
communities.

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://e2e.ti.com/
http://www.43oh.com/
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5 Schematics
Figure 9 shows the schematic. Hardware design files can be found in the BP-BASSENSORSMKII Hardware Design Files.

Figure 9. Schematic

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://www.ti.com/tool/BP-BASSENSORSMKII
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